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What is Microsoft Windows? 
• Widely used operating system 
• Windows is a program (such as Word) 
• Allows you to communicate with your computer using a keyboard and mouse to tell it 

what to do 
• Allows you to run more than one program at a time 

Example: Think of Windows as an orchestra conductor. Just as an orchestra 
conductor makes sure all instruments work together to create music, Windows makes 
sure all parts of the computer (hardware and software) work together.  

• Opens each program in a separate window 
• Learning to manage the different windows will allow you to work with several different 

programs at once 
• The components of a window are consistent, so you can apply what you learn in this 

workshop to any program that you run in Windows 
• Flexibility – there is more than one correct way to perform a task 
• Users can customize Windows, making it easy to get to frequently used applications 

and files easier 
• Desktops are customizable and will look different from computer to computer 
• Versions of Windows include: 95, 98, Me, NT, 2000, XP 

 
What is Software and Hardware? 
Software and hardware work together to allow you to communicate with your computer, make 
choices, respond to messages, and request info stored on your computer.  
 
Software 

• AKA: Application Programs 
• Examples include: Programs like the Microsoft Office suite; Word, Excel, PowerPoint, 

and Access 
• Software is loaded into the computer’s memory, accessed when the program is 

opened, and is displayed on the monitor 
• A program allows the user to perform different tasks on the computer  
• Programs are used to create files for the user 
• Versions of Office include: Office 95, Office 97, Office 2000, Office XP 

 
Hardware (Input / Output devices) 
Hardware consists of items that you can touch: 

• Monitor – display unit that lets you see what you are inputting 
• Keyboard – input device with 101 keys used to type data into the computer 
• Mouse – point and click input device 
• Memory – storage area for software and files 
• 2 types: 

o Hard drive – Permanent storage for all the info available on your computer  
o RAM – Random Access Memory is temporary storage. Software is installed on 

the hard drive and when a program is accessed is loaded into temporary 
storage for use. When a program is closed it is taken out of RAM, but still 
remains on the hard drive. 
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Folders  
• Folders are storage areas created by the computer or the user  
• Folders contain a group of documents that are related by topic 
• Folders are useful when managing files 
• Folders can be created, named, renamed, and deleted by the user 
• Note: Folders created by the computer should not be tampered with, they contain files 

that the computer needs to run the computer or access programs. 
 
Files  

• A file is a collection of information that a computer uses in a particular format 
Example: If you create a Microsoft Word document, the file is saved so that Microsoft 
Word can read and open it 

• Files are made up of two parts: the file name and the extension, separated by a period 
(filename.ext) 

 
1) File Name – The file name is the first part of the file. The file name can be up to 255 
characters long in Windows 95, 98, 2000 or XP. Files created by the user are named 
by the user. When naming a file, keep the name short and descriptive. The name 
should describe what the particular file is about.  

2) Extension - The extension is the second part of the file. It is usually three 
characters long. The extension tells the computer which program to associate the file 
with. 

Example: If you create a document in Microsoft Word, the computer automatically 
assigns that file the extension .doc. That information tells the computer that it is an MS 
Word document, and should be opened using Word. 

Program File Extension 
Word .doc 
Excel .xls 
PowerPoint .ppt 
Access .mdb 

 
 
Document 

• A document is a file that contains information that the user can view or hear 
Examples: a word processed letter, memo, or budget spreadsheet.  

• Documents are usually created and edited using programs such as Word 
�

Text 
• Text is data that is typed into a document via the keyboard 
• Text is comprised of letters, numbers, and symbols 
• Text can be moved, edited, formatted, or deleted 
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Microsoft Windows Operating System 
 

Turning on Your Computer 
Press two buttons: 

1. Monitor – green light displays when monitor is on 
2. CPU – larger button with light in the center (green when the CPU is on) 

 

Launching Windows 2000 
When you turn on a computer with Windows installed, the Windows operating system loads. 
You will see a screen telling you what version of Windows you are running. Once Windows is 
fully loaded, you will see a screen called the desktop. Each window you open sits on this 
desktop. Sometimes windows are so large you can’t see the desktop behind them, but it’s 
always there. The desktop is just like your own desk, you can keep it as orderly or as messy 
as you like. We will learn how to customize your desktop later in the workshop. Windows 
gives you a tool that makes it easier to keep things tidy as you move from task to task, the 
taskbar, located at the bottom of the window. 
 

Parts of the Desktop 
Taskbar – The bar along the bottom of your desktop screen that organizes all the 
windows that you open in one place. The taskbar contains the Start menu, quick 
launch buttons, taskbar button area, and the tray status area. 

Start Menu – Click once on Start to access the menu that lets you begin 
running a program, shut the computer down, search for files, access help, or 
make changes to your computer settings.  
Quick launch buttons – Customize this area to include programs that you use 
frequently. Click once on these icons to easily launch programs that are often 
used. 
Taskbar button area – This area displays a separate button for each program 
that’s open. 
Tray status area – This area contains the date/time and any programs that are 
running in the background (such as anti-virus and Novell NetWare Services). 

Mouse pointer – A mouse controlled arrow that appears up on the desktop. The 
mouse pointer allows you to point anywhere on the desktop or in a window. 
Icon – A graphic (or picture) with a title that represents a program, folder, or file. When 
you double click on the icon it will open the program, folder, or file. 
Object – An item on the desktop such as an icon 
Properties – Each object has unique attributes that effects what can be done to the 
object or what the object does.  
To see what properties the object has: right click on the object / Properties 

 

Icons Frequently seen on the Desktop 
 

 Note: Double clicking on an icon will open a program, folder, or file. 
 

My Computer – Double click the icon to view all the contents of your computer. 
My Documents – Double click the icon to access the My Documents folder. The My 
Documents folder is a good place to save personal files. 
Network Neighborhood – Double click the icon to see all the computers in your 
network. 
Recycle Bin – Double click the icon to see what items have been deleted. 
Shortcuts – Create shortcuts on your desktop to access frequently used programs, 
folders, or files quickly. 
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Parts of a Window 
 

Title Bar 
Active Window 
Window Control Buttons 
Dropdown File Menus 
Toolbars 
Window Border 
Scroll Bar  
Status Bar 
Dialog Box 

 
 

Title Bar  
The Title Bar is the blue bar across the top of the window that tells you what program you 
are using and title of the file that is open. It also includes the windows control buttons. 
 

Active Window 
The title bar on the active window is usually blue. Title bars on inactive windows are gray.  
Only attempt to access menu items on the active window. The active window has a recessed 
button on the taskbar. 
 

Window Control Buttons 
Windows allows you to have multiple windows open at the same time. You can easily switch 
between creating a course syllabus in Word, surfing the Web, or checking your email. Use 
the control buttons at the top right corner of the window to close, minimize, or change the 
size of the window. 

 

Minimize Button Click this button to close the current window, but keep the application 
open. To see the window again, click the button on the Windows taskbar, 
usually found at the bottom of your screen. 

 

Restore Button This button only appears when a window is maximized. Click it to make 
the window smaller.  

 

Maximize 
Button 

Click this button to enlarge the window to fill the entire screen.   
 

 

Close Button This button closes the current window. Before closing a window, check 
the title bar to be sure you're closing the right one. If you try to close a 
document that you have not saved, Word asks if you want to save 
changes first. This is a safeguard against losing work.  

 

 

When you are in an application such as Word, you will see 2 sets of control buttons:   
 

 
The set on the blue task bar (top) controls the program window. 
The set below (on the gray bar) controls the active document. 

 

Menus  

Under the program's title bar, you'll see the menu bar, which begins with the File menu. 
Open a menu by left clicking on its name. Each menu offers options for use in the program. 
Most menu options have an icon on the toolbar. Accessible commands are in black type 
while dimmed commands are grayed out and aren’t available at that time.  
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Toolbars      
Most programs have several toolbars. Toolbars are comprised of icons that represent specific 
commands. 

 

Tip: Point your mouse to the toolbar icon to find out what a button on a toolbar does. A 
yellow box pops up with the name of the button.  
  
Tip: Add and Remove toolbars by going to the View menu and selecting Toolbars. 
Place a check by the toolbars that you want to add by clicking on the name of the 
toolbar. Uncheck the toolbars that you want to remove by clicking on the name of the 
toolbar with a check by it. 

 

Window Border 
The window border is the line that surrounds the window. The window can easily be resized or 
moved by dragging. 
 

Move an object by dragging 
Point to an item, hold down the left mouse button, move the item to the desired location, and 
release the left mouse button.  
 

Resize a window by dragging 
Drag the border of the window to change the size of the window. 
Position the mouse pointer over the border until it becomes a two-pointed arrow, click, move your 
mouse in or out to size the window as you want it. 

 

Scroll Bar  
A scroll bar is a bar that displays at the right side and/or bottom of a window when the window 
contents are not completely visible. The size of the scroll box depends on the amount of window 
that is hidden.  
 

The scroll bar consists of three parts: 
1. Scroll arrows 
2. Scroll bar 
3. Scroll box 

 

Note: Scroll the window by clicking and dragging on any of the three parts.  
  

Status Bar 
The status bar at the bottom of the window provides information about your document.   
 

Dialog Box 

 
 

A dialog box displays whenever Windows needs to supply you with information to you or requires 
you to enter information or select among several options. This is like having a conversation with 
your computer. 
 

Examples include:  Prompting you to save changes to a file before closing the program or 
showing the status of copying a file from folder to folder. 
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Mouse Operations 
 
A mouse is an input device connected to the computer that’s used for pointing and 
clicking to help you navigate around the screen. 
IntelliMouse has three buttons: 

• Primary mouse button (most often used) – left click, single click 
Left click when you want to select buttons, menus, and commands. Also left click 
when you want to open a shortcut, program, folder, or file by double clicking on 
the icon or title. 

• Secondary mouse button – right click when you want to see shortcut menus 
Allows you quick access to some of the options that are hidden in the menus 

• Wheel button (optional) – middle rolling button  
Allows you to scroll through text or web pages quickly 
 

Mouse  � 

Point Move the mouse across a flat surface (typically a mouse 
pad). 

Click Press the left mouse button and release. 

Left click/Single click The left mouse button is used most often. Click once on the 
left mouse button to move the blinking cursor to a menu, 
select items from toolbars, select or highlight, close or 
minimize windows. 

Right click Click once on the right mouse button to quickly access 
shortcut menus (object menus). 

Double-click Click twice fast on an icon with the left mouse button to 
open a program, folder, or file. 
(it's best to click on icon itself, rather than on icon’s title) 

Click and drag Click and hold, move the mouse, then release. 
Use to move something or copy a file from one place to 
another. 

Right drag Good for moving files or text, click hold down and choose 
copy here. 

Left Handed Options If you are a lefty, you can configure your mouse to work the 
opposite way. To do this go to: 
 
Start menu / Settings / Control Panel / Double click on 
Mouse / Buttons tab / Button configuration / Left handed 
 
Left click/Single click - Click once on the left mouse button 
to quickly access shortcut menus (object menus). 
 
Right click – The left mouse button is used most often. Click 
once on the left mouse button to move the blinking cursor to 
a menu, select items from toolbars, select or highlight, close 
or minimize windows. 
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Keyboard Operations   
 

 
 

 

Keyboard Key 
 

 

Function 
 

Escape Same as cancel – gets you out of almost anything. 
Function keys The F1 through F12 keys are function keys. 

Example: pressing F1 will bring up the help menu. 
Second Row: 
 
Numbers     0 through 9 
 
Symbols      ! @ # $ % ^ & * ( )  
 

 

To type numbers, press the number key. 

To type symbols, press and hold down the Shift key 
while pressing a number key. 

Special Characters:  
Tilde ~ Tilde is used in the addresses of some Web pages. 

 
Dash, Underline, Plus, Equals 
- _ + =  
 

 

Special Button: 
 
Backspace 
 

 

When typing, Backspace moves the blinking cursor to 
the left, deleting text. 

Third Row: 
 
Contains mostly letters 
 
 

 

• To type lower-case letters, press the letter key 
• To type capital letters, press and hold down 

the Shift key while pressing a letter key 

Special Button: 
 
Tab 
 

 

The tab key moves you from field to field in a form or 
dialog box. 

Special Characters: 
 
Brackets and Parenthesis { [ ] } and | \ 
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Fourth Row: 
 
Contains mostly letters 
 

 

Special Buttons: 
 
 

 

Caps Lock When Caps Lock is on all typed text is UPPER CASE. 
Using the Shift key while Caps Lock is on will produce lower 
case text. 

 
Enter 
 

 
Enter or Return acts like the carriage return on an electric 
typewriter. Press Enter to create a new line or adjust line 
spacing. 

Special Characters: 
 
 : ; “ ‘ 
 

 

Fifth Row: 
 
Contains mostly letters 
 

 

Shift To type a capital letter, press and hold down the Shift key 
while pressing a letter key. Shift is also used when typing 
symbols located on the number keys. 

Special Characters: 
 
< , > . ? / 
 

 

Sixth Row: 
 

 

Windows key 
(or Ctrl-Esc) 
 

Same as clicking on Start button. 

 
Space bar Pressing the space bar moves the blinking cursor one space 

to the left. This puts spaces between words. 
 
Ctrl 
 
Alt 

 
Many programs use Alt and Crtl keys along with letter keys 
to do useful functions such as keyboard shortcuts 

Print Screen 
 
Scroll Lock 
 
Pause / Break 
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Six Middle Keys:  

 

 

Insert Allows you to insert text over text, replaces the text that’s 
there.  
 

Delete Pressing the delete key will delete text. Place the blinking 
cursor in front of the text that you want to delete, then press 
delete. 

Home Takes you to the beginning of a line of text. 
End Takes you to the end of a line of text. 
Page Up Moves text up one screen. 
Page Down Moves text down one screen. 
Arrow keys Moves the blinking cursor left, right, up, or down. 
Num Lock 
 

When Num Lock is on, the number pad keys produce 
numbers.   
 
When the Num Lock is off, the number pad keys have 
secondary functions: 
 
Home, Page Up, End, Page Down, Insert, Delete, Enter, 
Arrows 
 
The symbols of the keypad are:  
 

• +  for addition.  
Ex: "2 plus 3 equals" is typed: 2 + 3 <Enter>  

• -  for subtraction.  
Ex: "5 minus 1 equals" is typed: 5 - 1 <Enter> 

• /  for division.  
Ex: "12 divided by 2 equals" is typed: 12 / 2<Enter> 

• *  for multiplication.  
Ex: "12 times 15 equals" is typed: 12 * 15 <Enter>  

• Enter calculates the answer. 
 

 
 

Keyboard Shortcuts 
 

There are two types of keyboard shortcuts: 
 

Single Key Shortcuts  
  
 
 
 
Multiple Key Shortcuts 
 

• Alt + letter  
(ex: Alt + F to see File 
menu) 

 

• Ctrl + letter  
(ex: Ctrl + S to save) 

 

 
Pressing just one key will cause an action to happen.  
Examples: Pressing a function key such as F1 will open the 
help menu or pressing the Windows key will open the start 
menu 
 
Press and hold down one key then press a second or third 
key 
 
Opens a menu listing (inside an application) 
 
 
Shortcut way of executing an item on a menu 
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 Keyboard Key or Key Combination Action 
F1 Opens the Help menu for any program that is in the active window 
Tab Moves you from field to field in a form or dialog box 
Shift + Tab Moves you backwards from field to field in a form or dialog box 
Ctrl + Home Moves you to the beginning of the page 

Shift + Arrow Highlights text 

Ctrl + Alt + Delete  Ends a hung program 

Caution: Pressing Ctrl + Alt + Delete two times will shut your 
computer down 

ALT + TAB Switch between open programs 
ALT + F4 Quit program 
SHIFT + DELETE Caution: This will delete an item permanently 
SHIFT + F10 Opens a shortcut menu for the selected item  

(this is the same as right-clicking an object) 
SHIFT Press and hold down the SHIFT key while you insert a CD-ROM to 

bypass the automatic-run feature 
ALT + SPACE Displays the main window's System menu  

(from the System menu, you can restore, move, resize, minimize, 
maximize, or close the window) 

ALT+ underlined letter in menu Opens the menu inside the program 
ALT + F4 Closes the current window 
ALT + F6 Switch between multiple windows in the same program  

(for example, use this shortcut to switch between several Word 
documents that are open at once) 

Windows Logo + M Minimize all 
SHIFT + Windows Logo + M Undo minimize all 
Windows Logo + F1 Windows Help 
Windows Logo + E Windows Explorer 
Windows Logo + F Find files or folders 
Windows Logo + D Minimizes all open windows and displays the desktop 
Windows Logo + TAB Cycle through taskbar buttons 
Windows Logo + R Opens Run dialog box  

Windows Program Key Combinations 
For a selected object:  
CTRL + C Copy 
CTRL + X Cut 
CTRL + V Paste 
CTRL + Z Undo 
CTRL + B Bold 
CTRL + U Underline 
CTRL + I Italic 
F2 Rename object 
F3 Find all files 
ALT + ENTER Open the properties for the selected object 

Dialog Box Keyboard Commands 
SPACEBAR If the current control is a button, this clicks the button. If the current 

control is a check box, this toggles the check box. If the current 
control is an option, this selects the option 

ENTER Equivalent to clicking the selected button (the button with the 
outline) 

ESC Equivalent to clicking the Cancel button 
ALT + underlined letter in dialog box 
item 

Move to the corresponding item 
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Time Savers / Customizing Your Desktop 
 

Creating Shortcuts 
Use shortcuts to quickly access files, folders, programs, or printers that you use often. Short 
cuts can be put on the desktop, in folders, in the Start menu, or on the Program menu.  

To put a shortcut on the desktop  
• Right click on My Computer 
• Choose Explore 
• In the right pane of Windows Explorer right click the item for which you want to 

create a shortcut  
• Right click and choose Send To > 
• Choose Desktop (create shortcut) 
 

Tip: 
• To change any settings for the shortcut right-click the shortcut, and then click 

Properties 
• To delete a shortcut, drag it to the Recycle Bin. Don’t worry! The original item will 

still exist on the hard drive 
 

Creating Quick Launch Buttons on the Windows Taskbar 
To create a quick launch button for Word: 

• Follow the directions for putting a shortcut on the desktop (above) 
• Single left click on the shortcut, hold down and drag the icon to the quick launch 

button area of the taskbar (right of the Start menu) 
• Drop the icon when you see a black vertical bar 
• The quick launch button will now be displayed on the taskbar 
• Click once on the icon to access the program, folder, or file that you created the 

quick launch button for 
 

Finding Files 
Quickly search your computer for a specific file or folder by clicking on the Start menu and 
choosing Find. Click on Files or Folders… Type in the name of the file or any part of the 
name of the file. Choose the appropriate drive. Click Find Now. The computer will search for 
files or folders based on the criteria that you give it.  

 

Help! 
Press the F1 key to get help with any program that is in your active window. To get help with 
Windows, make sure you are on the Desktop and press the F1 key.  
 

Moving Text and Files 

Copy and Paste      
• Select a block of text or file that you want to 

copy to another location 
• Go to the Edit menu select Copy 
• The original text remains in the document and a 

copy goes onto the clipboard 
• Move your cursor to the new location and then 

go to Edit / Paste 
• For a shortcut use the Standard toolbar's Copy 

and Paste buttons  
• Or use the keyboard shortcuts: Ctrl + C then 

Ctrl + V 

Cut and Paste       
• Select the text or file that you want to move from one 

location to another 
• Go to the Edit menu and select Cut 
• The text will disappear from the document. 

(the text is temporarily stored in your computer's 
clipboard)  

• Move your cursor to the new location and then go to 
Edit / Paste 

• For a shortcut use the Standard toolbar's Cut and 
Paste buttons  

• Or use the keyboard shortcuts: Ctrl + X then Ctrl + V 
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File Management 
 

Creating Files 
 

Creating a new file in Microsoft Office is easy! Simply open the program that you want to use. 
 

Open a Program by: 
• Go to the Start menu and click once  
• Go up to Programs 
• Go over to the Program you want to open 
• Click on it! 
• A new file is automatically created for you 
• Once you are in a Program create new files by going to File / New 

 

Saving Files 
 

Note: If you are saving files to a floppy, make sure there is a floppy disk in the A: drive 
 

1) Create a document that you want to save 
2) To Save a File for the First Time: 

• Go to the File menu and select Save 
• The Save As window appears 
• The Save In box at the top of the window shows the location where you are about to 

save your file  
• Select the location where you want to save your file by clicking on the drop down 

arrow and selecting the drive AND folder where you would like to store the document 
• *** Keep in mind that the A Drive is the floppy drive *** 
• Type the file name in the File Name box 

(The file name can be up to 255 characters long and may contain spaces) 
• Finish saving the file by clicking Save 

3) Saving Changes to an Existing Document: 
After editing your document you will want to save changes. 
• Go to the File menu and select Save  

4) Save Often!!!  
Note: Make it a point of saving your document before trying something unfamiliar, before 
printing, before switching to another application, and before leaving your computer. 
 

If you forget to save a file before closing the program a Dialog Box will pop up and prompt 
you to save changes. 
 

Copying Files to a Floppy Disk 
 

A quick and easy way to copy a file (or folder) to diskette: 
1) Right-click on the file you want to copy to diskette 
2) From the context menu, choose Send to, then choose 3 ½ floppy (A) 
 

To copy multiple files (or folders) to diskette easily: 
1) Select the files you want to copy (by Shift-clicking, Ctrl-clicking, or Select all) 
2) Right-click anywhere on the selection 
3) From the context menu, choose Send to, then choose 3 ½ floppy (A) 
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Opening Existing Documents 
 

To open a saved document: 
• Go to the File menu and select Open 
• The Open window appears 
• Use the drop down arrow to find the drive AND folder where the document is saved. 

Once you find the file you have two options for opening it: 
� Double-click it 
� OR Select the file by single clicking on it and then click Open 

 

Save vs. Save As… 
 

Use Save when you are  
1) saving a file for the first time  
2) OR when you want to save changes to a file 
 

To Access Save: 
• Use the drop down menu: File / Save 
• OR use the Toolbar Icon  

 

Use Save As… when you want to make a second copy of the file using a different name.  
For example: Save As… is useful when you have a file that is updated each semester. Use 
Save As… to make a copy of the file with a new name, make necessary changes, and then 
save the file (under the new name). 
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File Organization 
 

There are two ways to see the files or folders on your computer: 
 

• My Computer  
Double-click on the My Computer icon to see all your drives (plus a couple of extra 
folders).  Double-click on any drive to see its contents. 
 

• Windows Explorer (right click My Computer / Explore) 
Windows Explorer is a Program in Windows that allows you to view the contents of the 
computer, hierarchy of the folders, and files and folders in each folder. It helps you 
organize folders and files. 

• Work with folders and folders 
• Select, copy, and move files between folders and drives 
• Create, rename, and delete folders or files 

 

Windows Explorer Basics 
 

To start Windows Explorer: 
• Right click on My Computer / Explore 

 

Windows Explorer is divided into two panes: 
• Left pane – Shows the Folder/Drive hierarchy on your computer.  

Each folder or drive has an icon and a folder name 
� Click on the folder or drive in the left pane and its contents will be displayed 

in the right pane 
• Right pane – Shows the contents of the selected Folder/Drive  

 

Subfolders (folders within folders) 
• Collapsing the folder (click – sign) 
• Expanding the folder (click + sign) 

� Click on the +/- to expand/collapse the folder 
 

Example:  
Think of Windows Explorer as a file cabinet in your office.  

� Drive = file drawer 
� Folders = file folders 
� File = document or letter to go in the file folder 

 

Change the List View of Folders 
Go to the View Menu to see four different views of the contents in the right pane 

• Large Icons – Large picture with name 
• Small Icons – Small picture with name 
• List – Small picture with name in an ABC list 
• Details – More info: Small picture with name, size, file type, and date modified 

 



 15 

Creating a Filing System 
 
Create Folders 
The first thing you want to do is to set up a filing system by creating folders to hold your files 
and documents. The idea here is for you to have a plan that works for you and follow it.  You 
can choose any type of scheme that fits the way that you work. You may want to create 
folders for the various types of documents that you generate or receive. Create some generic 
folders like: Budget, Financial Records, Requisitions, Staff Meetings, Committees, and 
Course Titles. Folder names should be short, but descriptive. 
 
Create Subfolders 
Subfolders can be used to break a broad category down into more specific parts. 

Example: 
You might be on more than one committee. Organize your committee files by: 

1. Creating a Folder called Committees 
2. Creating two subfolders called Budget Review and Professional Development 
3. Saving documents related to the same topic in folders / subfolders together 

 
Create and Save Files 
Create a file and give it a name that is both short and descriptive. File names should be 
something that you can remember. Since short file names are easier to work with, try to keep 
your file names to 20-30 characters. Remember to save files in folders and subfolders with 
documents of similar content. 
 
Think of a filing system like a tree with many branches: 

• Trunk = hard drive  
• Large branches = folders  
• Small branches extending from the large branches = subfolders 
• Leaves = files/documents 

 

Hard drive 

Folder 

Sub folder 

Files 
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Using Windows Explorer 
 

Before saving a file to your computer or a floppy, you will want to create some folders to help 
you get organized. 
 

Creating Folders 
• Click once on the appropriate drive in the left pane to highlight it  
• Go to the File menu and select New / Folder 
• The New Folder will appear in the right pane  

Make sure New Folder is highlighted, then type in a name for the folder.  
The title New Folder will be replaced with the name you give the folder. 

 

Rename Folders or Files 
• Find the folder or file that you want to rename by navigating through Windows Explorer 
• Click once on the folder or file you want to rename (this can be in the left or right pane) 
• Go to the File menu and select Rename 
• With the folder or file highlighted, type in a new name for the folder or file  

 

Delete Folders or Files 
• Find the folder or file that you want to delete by navigating through Windows Explorer 
• Click once on the folder or file you want to delete (this can be in the left or right pane) 
• Go to the File menu and select Delete 
• The file will be deleted from its current location and placed in the Recycle Bin 

 

Retrieving Folders or Files from the Recycle Bin 
• Double click on the Recycle Bin icon on you Desktop to display contents of the 

Recycle Bin 
• Move deleted items out of the Recycle Bin by single clicking on the item and dragging 

it out of the Recycle Bin 
• You might want to drag the file from the Recycle Bin to your Desktop 

 

Selecting Files  
Before moving, copying or deleting files they must be selected in the right pane. 

• One file – single click 
• Select a continuous group of files – Click on the first file in the group / Hold down the 

Shift Button / Click on the last file in the group (all files in between are highlighted) 
• Select a group of non-successive files – Click on the first file / Hold down the Control 

Button / Click on other files (just the files you click on will be highlighted) 
 

Moving or Copying Files from Folder to Folder 
• Left pane – Choose the correct drive and folder where the file is stored 
• Right pane – Find the file(s) and select 
• With the file selected, drag (click the mouse and hold down) the file or folder from the 

right pane to the destination folder in the left pane (until the destination folder in the left 
pane is highlighted) 

• Drop (take your finger off the mouse) 
• Click on the folder in the left pane to make sure the file or folder was moved to the 

correct place (contents of the folder will be displayed in the right pane) 
Note: When you drag a file from one place to another within a drive � it moves. 
 When you drag files from one drive to another (ex: from C to A) � it is copied. 
 

Closing Windows Explorer 
• Click the X control button in the top right hand corner of the window 
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Microsoft Office Professional 
• Word 
• Excel 
• PowerPoint 
• Access 

 
To see what Programs (software) are loaded on your computer or to open a Program: 

• Go to the Start menu and click once  
• Go up to Programs 
• Go over to the Program you want to open 
• Click on it! 

 
Features of Microsoft Word   

• Word processing program that allows you to type, format, and edit text 
• Word's pull-down menus, toolbars, and buttons make learning and using Word easy 
• Helps you produce professional-looking documents 
• Allows you to insert graphics into Word text documents  
• Allows you to create tables 
• Allows you to create mail merges 

 

The Page 
Word presents documents as blank pages of paper. The blinking vertical bar is the 
cursor. Begin typing at the blinking cursor. Anything you type appears to the left of this 
insertion point. A mouse-activated, movable vertical bar (I-beam) allows you to place 
the cursor on the page. The insertion point and bar do not print.  
 

Selecting a Block of Text to Be Formatted 
Before you can change a block of text - for example: move; bold underline; change the 
font or font size; or copy it - you have to select it. When you move your arrow pointer 
over the document page, it changes shape to what is called an I-beam.   

• Place the I-beam at the start of the text you want to change 
• Press and hold the mouse left button 
• Drag the I-beam over the text 
• Release the mouse button when the text is highlighted or selected 
Tip: Select one word at a time by double clicking on the word 

 

Deleting text 
• Backspace - back up over one character at a time 
• Delete - erase one character to the right of the cursor 

 

Word Wrap 
Text automatically wraps to the next line as you reach the right margin. If you are used 
to using a typewriter, you need to break the habit of pressing Enter at the end of every 
line. Unnecessary returns can cause problems later if you change your text's 
formatting. Use the Enter key only when you want to create a new paragraph.  
 

Tip: Create a blank line in your document by pressing Enter twice. 
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Features of Microsoft Excel   
• Spreadsheet program that allows you to organize data 
• Enter and calculate data 
• Use Chart Wizard to put data in picture format 
• Use as a database – once data is entered Excel can sort, search, and select data that 

meets specific criteria 
• Web Support – save workbooks or sheets in HTML 

 
Parts of Excel 

• Workbook – Comprised of worksheets 
o Column heading 
o Column (vertical) 
o Row heading 
o Rows (horizontal) 

 
• Worksheet – Single sheet in the workbook 

 
• Sheet tabs 

 
• Cells 

o intersection of a column and a row  
o place where data is entered 

 
• Cell reference  - Unique address comprised of a column and a row 

 
• Active cell – A cell that’s selected 

o Border around cell 
o Address listed in name box 
o Column and Row headings are bolded 

 
• Gridlines – Horizontal and vertical lines in worksheet, makes data easier to read 

 
• Mouse pointer – Block plus sign when pointed over cells in worksheet 

 
• Block arrow – When mouse is pointed outside the worksheet 

 
Entering data in a cell 

• Select the cell by clicking in a cell - a black border will appear around the cell 
• Enter text – type, left aligned  
• Use arrow keys (or tab key) to navigate through the worksheet 
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Features of PowerPoint   
• Presentation graphics program 
• Produce professional looking presentations in a slide show format 
• Add tables, chart, pictures, video, sound, and animation 
• Word processing capability 
• Outline information for a concise presentation 
• Create handouts 

 
Various ways to present a slide show 

• Project your slide show by using a projection device and a computer 
• Make transparencies 
• Create presentations for the web 
• Easily create handouts to go along with slides 

 
PowerPoint Basics 

• The basic unit of a presentation is a slide 
• Slides contain objects such as title, text, graphics, tables, charts 
• PowerPoint allows you to use default settings or create your own. Defaults include 

placement of objects, color schemes, design templates, and slide transition.  
• Objects have attributes or properties such as underlining, bold, text color font size, and 

font style.  
 
Features of Access  

• Database program that allows you to work with a collection of data in an organized 
manner 

• Users can access, retrieve, sort, and use data 
• Database is a collection of tables  

 
Allows you to create 

• Queries – find specific information in a database 
• Forms – easy to use for viewing, adding, and updating data 
• Reports – professional looking way to display information 
• Web Support – save as HTML to put up on the web 

 
Tables consists of two parts 

• Records – rows that contain all the information about one record 
• Field – columns that contains specific information about a record (example name, 

office number, phone number) 
 
The Structure of a Table 

• Field Names – must be unique 
• Data type – what kind of data will the field have? Numbers? Letters? 

o Text – any characters (numbers or letters) 
o Numbers – only numbers (positive or negative) 
o Currency – only dollar amounts (displayed with $, commas, decimal points, and 

2 numbers after decimal point 
• Description of the field (optional) 
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Shutting Down the Computer 
 
Before shutting down the computer, you should close all open windows by clicking the X in 
the top right hand corner of each window. Be sure to save any changes that you’ve made to 
files before closing the program.  
 
Shut down the computer by clicking on the Start menu and choosing Shut Down. It takes a 
moment for the computer to shut down, so be patient. Turn the monitor off by pressing the 
power button on the monitor. 
 
 

 


